
 

 

 

 

EAW Resolution v2.10.0.138  Release Notes 

Previous Version: EAW Resolution v2.9.2.22  

Added Network and Control Support for AC6 
 

 
 
 
 
 
 
 
Improved Adaptive system health functionality 
 

 
 
 



 

 

 

General Features and improvements 

• Improved venue detection. 

• Improved network communication for systems with a large amount of online devices. 

• Fixed UX/UXA mute buttons in Network View. 

• Improved firmware update process and reliability for daisy chained devices. 

• Minor bug fixes for ADAPTive Air Loss. 

• Remember which PEQ is selected when toggling inputs/outputs in Processor. 

• Disable or Hide "Coverage & Modify Coverage" for Non-Adaptive Products. 

• Resolution now should request and recognize the processor type in Radius hardware info response. 

Firmware Updates 

• Initial release of AC6 firmware 

• SBX, NTX, RSX improved firmware to support latest hardware version 

• Update Anya firmware that fixed a bug that could cause a momentary (2-3 seconds) audio mute or 
erroneous fault condition (rare case) 

EAW Resolution v2.9.2.22  Release Notes 

Previous Version: EAW Resolution v2.8.1.8  

Added Network and Control Support for Radius 
 RSX12, RSX208L 

RSX18, RSX18F, RSX212L 
 RSX86, RSX90 

RSX126, RSX129 
RSX218 
 

 
 
 
 
Radius Driver Test implementation 



 

 

 

 

 
 
 
 
 
 

 

 

 

 

 

 

 

 

 
Radius Array Optimize implementation 

Click “On” to start the 
test 

Select Passband to test 

Adjust the Level 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General Features and improvements 

• Acoustic model and SPL recalculate less frequently for venue edits 

• Network Stability Improvements for large scale systems 

• Speed, responsiveness, and usability improvements for large systems 

• Improved use of CPU and core split ups 

• System Health and parameter upload improvements 

• Bottom Height and clearance fields improved. 

• Improved Firmware upload support (Including RSX Series Firmware) 

• Improved support for “roll” of products 

• Automatic reconnection to online devices after PC sleep mode restart 

• Parameter copy/paste between processors and between channels 

• Improved Undo/Redo feature. 

• Added new Front View and ability to load front view elevation drawings. 

• Resolution 2.8 will rotate the drawing 90 degrees if you resave the file. 

• New data files for JF80z, JF60z, SB528z, SB250z, SB150z, SB180z, LS432i, LS832i, MK8126I, MK8196i. 

EAW Resolution v2.8.1.8  Release Notes 

Previous Version: EAW Resolution v2.8.0.37 

 



 

 

 

Adaptive Venue Detection Mode: Narrow or Wide. 

 There is now a new option under the Options menu. 

 

Example: 

One 10-modula Anna array aimed down a typical venue.  One side of the venue is show for illustrative purposes. 

 



 

 

 

Here, the coverage is set to Wide 

 

 

Coverage extends to the side of the arena. 

 

In this next figure the coverage is set to Narrow. 



 

 

 

 

 

Coverage is contained on the floor section. 

 

Show Sweep Lines & Show Venue Detection 

 There are new options under the View menu. 



 

 

 

 

 

Show Venue Detection 

Upon selecting to view this option, Resolution will display a pink line representing how the venue is being 

calculated. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Show Sweep Lines 



 

 

 

Upon selecting to view this option, Resolution will display a series of green lines showing which sections of each 

surface are being covered. 

 

 

 

 

 

 

 

 

 

 

 

Improvements 



 

 

 

Minor bug fixes relating to SPL recalculation engine. 

o Remove coverage extension property for Otto 

o SB818F shouldn't default to a rear Op Mode 

o Extend Coverage has no effect when using the "Narrow" venue detection mode. 

o Adjusting the SPL Range triggers an acoustic model calculation 

o Reintroduce old coverage method as an option 

o UX High Shelf, Low Shelf, Xmax, Vx Limiter are not reset when greyboxes are loaded 

o Filter Settings differ from 2.6.1 

o Base Delay for a Greybox leg is being set to the leg's Gain value 

o Frequency Response window migrates down the screen each time it is opened 

o Pulling settings from processor fails and can crash Resolution 

o Regression: Processor Shelf/PEQ Filter Gain zeroed is not reflected in EQ View 

o Complete KF810 / SB818 / FB / AB Data Files 

o Filter "Type" is unexpectedly greyed out when adding/removing Greyboxes 

o Wrong frequency is displayed for the HPF after a sub Greybox is loaded. 

o Text on the second line of the Missing Greybox dialog is missing the output leg numbers 

o UX network device name is not updated when "Pull" is selected. 

o Characters that are entered on the output channel strips of processors/amps are erased when 

clicking OK button in the Select/Configure Greybox popup window 

o Windows Stopped Working Error Appears When Attempting to Open .eawarray Files Via File > 

Open 

o High / Low Shelf shape adjustments by mouse scroll not reflected in value field 

o RSX212L RSX118F EASE GLL 

o In Drawings Properties Pane for a Side View Imported Image Manually Entering a Z value of 10 

Places Results in a 0 Value 

o UX name in the online devices list isn't updated when the online device is assigned to an offline 

device with a different name 

o Right clicking on a mute button in Network View toggles the mute and brings up the context 

menu 

o Add Greybox Name somewhere in Greybox Section and Perhaps on mixer 

o When creating a new Greybox the user should be prompted to assign an input if no input is 

selected 

o UX amp or dsp mute button greyed out 

o For HPF, and LPF should be able to enter a frequency beyond the allowable range to set filter to 

OUT 

 

 

 

 

 

EAW Resolution v2.8.0.37 Release Notes 



 

 

 

Previous Version: EAW Resolution v2.7.0.8 

Resolution 2.8 contains several improvements for modeling and support for new products. For any 
questions, contact the Application Engineering team at design@eaw.com. 

Key features in this release are listed below: 

SPL Map/Adaptive Settings Saved with File 

Acoustic SPL map and all steering settings are now saved with the Resolution file, allowing for quick 
display of SPL map upon loading a file, and quick upload of settings. 
 

 
Fig 1. Save Acoustic Model option 
 
 
 

 
Fig 2. Acoustic Info: display of what’s available to be saved 
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Fig 3. Save as *.eawcab 
 

Improved Venue Detection/Surface Detection 

Significant changes in adaptive algorithms and how venues/surfaces are analyzed.  Improvements in 
both calculations and coverage for multi surface venues. Detection of the venue and any obscured 
audience sections are significantly better than before, resulting in better adaptation. 
 
 
 
 
 
 
 
 
 
 
 
All examples below: SPL – Best, FLAT SPL, 1 octave 4k. Audience areas turned off for balconies. 



 

 

 

Example 1 

 
Fig 4. Previous method, Resolution 2.7                                        Fig 5. Improved Algorithm, Resolution 2.8 
 

Example 2 (Contour on) 

 
Fig 6. Previous method, Resolution 2.7.                                       Fig 7. Improved Algorithm, Resolution 2.8.                   
 
 
 
 
 
 
 
 



 

 

 

UX/UXA Improvements 

Small bug fixes.  Improvement to GUI and communications. 
 

Additional support for: 

MKD864 
MKD986 
MKD826  
MKD1064 
MKD1096 
MKD1026 
  
SB825 
SB828 
  
RS121 
RS151 
RS115  
RS123 
RS153 
RS118HP 
 

EAW Resolution v2.7.0.8 Release Notes 

Previous Version: EAW Resolution v2.6.1.111 

Resolution 2.7.0 contains a number of improvements for UX processor and amplifiers and includes 
support for new EAW products. For any questions, contact the Application Engineering team at 
design@eaw.com. 

Key features in this release are listed below: 

KF810P-80, KF810P-100, and SB818P-F Support  

Resolution 2.7.0 introduces support for the new KF810P-80, KF810P-110 loudspeakers and SB818P-F 
low frequency enclosure, providing total system optimization from anywhere in the venue, plus 
intuitive room design and prediction.
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Additional Changes and Improvements: 

Improvements and bug fixes to the UX Processor and Amplifier control and interfaces. 
 
Note: This version may automatically restart after installation depending on your system configuration.

Known Issues: 

When dragging an online UX device from the network to the workspace, temperature is set to 0˚ and 
humidity is set to 100%. 

 



 

 

 

EAW Resolution v2.6.1 Release Notes 

Previous Version: EAW Resolution v2.6.0.193 

Resolution 2.6 contains a number of improvements for modeling and includes support for new EAW 
products. For any questions, contact the Application Engineering team at design@eaw.com. 

Key features in this release are listed below: 

RSX212L & RSX18F Support  

Resolution 2.6 introduces support for the new RSX212L loudspeaker and RSX18F low frequency 
enclosure providing total system optimization from anywhere in the venue, plus intuitive room design 
and prediction.
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UX/UXA Processors and Amplifiers "Pull" feature  
 
UX and UXA series processors and amplifiers state can now be read upon discovery. 
 



 

 

 

Note: UX and UXA devices and files used with Resolution 2.6.1 are not backwards compatible with 
2.6 and prior versions of Resolution.  Use of 2.6.1 files or devices with 2.6 will result in unexpected 
behavior. 

 
 
 
 

 

 

 

Changes and Improvements: 

Adaptive Products 

• Adaptive aiming lines have been corrected.  

• Improved communications between software and Adaptive DSP parameters. 

• Coverage lines are no longer allowed to "shoot" thru venue surfaces. 

• Resolution no longer crashes trying to open Preset Dialog 



 

 

 

• Minor bug fixes to Anya Firmware.  Anya Firmware is updated to v1.0.58.1, previous version was 
v.1.0.57.1. 

UX Products 

• Bridging is now handled properly, depending on the greybox legs loaded. 

• Greybox dialog now displays the Rev # 

• Greybox legs now limited to 8 max. 

• Resolution will check UX FW and inform the user new FW is available 

• Amp and Processor names are limited to 12 characters.  If no processor name, model name is 
used. 

• Processor name is now synchronized properly 

• The user is notified when a Greybox definition cannot be found. 

• Improved communications with all UX devices. 

• Deleting UX device with any adaptive or non-adaptive speaker present no longer triggers 
acoustic model recalculation. 

• UX/UXA meters now respond after the online device is unassigned and reassigned  

• Limiter threshold returns to default when Greyboxes are unloaded  

General 

• Improved the interface for detailed 3D venues.   

• Improved interface for HPF and LPF control 

• Save no longer fails if the target directory or drive is missing 

• Arrays below minimum trim are now properly indicated 

• SPL C menu item added 

• Improved the display of Audinate error codes 

• Network view meters now cleared when Resolution goes offline 

• Re-running the array wizard now presents the user with an option to leave the Air Loss 
unchanged 

 
 
 
 



 

 

 

EAW Resolution v2.6.0.193 Release Notes 

Previous Version: EAW Resolution v2.5.0.78 

Resolution 2.6 contains a number of improvements for modeling, and includes support for new EAW 
products. For any questions, contact the Application Engineering team at design@eaw.com. 

Key features in this release are listed below: 

 

UX/UXA Processors & Amplifiers 

Resolution 2.6 introduces support for the new EAW UX series which includes the UX48 System 
Processor and EAW UXA4406, UXA4410 and UXA4810 Amplifiers. This provides the user with complete 
control and monitoring of key processor and amplifier controls and ensures the best possible 
performance of an EAW sound reinforcement system through seamless integration of EAW’s Greybox 
technology. Together, EAW Resolution and UX series allow setup and operation in a fraction of the 
time required with other amplification systems.  

Click the “+” symbol next to Processors & Amplifiers under the Project explorer window to add to the 
system: 

 

 

 

 

 

 

A dialog will appear allowing users to name and select the exact product being used: 
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Once a processor or amplifier has been added to the system, the user will be provided with the option 
to add Greyboxes and edit DSP parameters: 

 

 
 

 

 

ANYA V2 Amp Module 



 

 

 

This will be seamless to the user allowing for mixed arrays of v1 and v2 ANYA amp modules (assuming 
all voicings are correctly loaded).  

Other Changes and Improvements: 

• Resolved an issue where Resolution could crash when creating a New System using the 
keyboard shortcut. 

• Network>Configure... has been renamed to Network>Configure Dante... 

• Resolved an issue where Firmware Updates sometimes reported success when they had failed. 

• Resolved an issue where the Parameter Sync dialog could show duplicate entries. 

• Resolved an issue where the Array meters in Network View continued to show the last level 
after the network had been disconnected. 

Known Issues: 

• EASE export may fail for larger Anya arrays. 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 

o Workaround: Retry log request. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction because arrays default to aiming in the +X direction. 

o Workaround: Adjust panning so that array is aimed in –X direction (180 degrees). This 
can be done in the second page of the Array Assistant. 

• The PC may need to restart upon completion of the Resolution installation due to the updates 
to Dante Services if they are outdated. 

o Workaround: None. Allow computer to restart. Do not install new versions of 
Resolution in situations when it is critical that the computer not be restarted. If other 
programs are running, Windows will prompt the user to save their work before closing. 

o  

 
 

 

• Resolution may warn that an array is ‘below minimum trim’ when it is actually not, based on the 
value set in the ‘Properties’ pane. 

o Workaround: Re-run Array Assistant with modified Min Trim value. Warning should 
disappear. 

 

 

 

 

 

 

EAW Resolution v2.5.0.78 Release Notes 

Previous Version: EAW Resolution v2.4.0.87 



 

 

 

Resolution 2.5 contains a number of improvements for modeling of all EAW products and control of 
Adaptive systems. For any questions, contact the Application Engineering team at design@eaw.com. 

Key features in this release are listed below: 

External Image Import 

Users can now import external graphical images as plan and sections views in order to aid the rapid 
building of Resolution models from architectural drawings. BMP, JPG, PNG and GIF file formats are 
currently supported. To add an image, locate “Import Drawing” under the “File” menu, or the 
“Drawings” item in the Project Explorer pane and click the “+” button to begin the import process: 

 

A dialog will appear allowing users to scale and locate the drawing within the 3D Resolution model in 
both plan (XY planes) and section (XZ and YZ planes) views. After importing an image, users can simply 
overlay venue surfaces to the model as they normally would. This feature allows users to quickly 
generate 3D Resolution models based on architectural drawings, as shown below: 

 
 

Adaptive Health Display 

For Adaptive Systems users, the health of the current online system can now be easily viewed in a 
single location via this new feature. Though fault detection and Adaptive Healing are not new features, 
this display increases the ease of use for system technicians and engineers in show environments by 
assembling all available information in one place and providing guidance on when it is necessary to act 
on issues and when they are unlikely to have any noticeable impact on system performance. 
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While online and assigned, Resolution will continually monitor the status of all modules in the system. 
The status of the system is visible in the lower-right hand corner of the main window.   
 

 
 
The display can have one of three states, each of which is shown below: 
 

 
Green: No issues. System health is at 100%. 
 
 
 

(Continued on next page) 
 
 



 

 

 

 
Yellow: Errors or faults detected, but acoustical impact is less than 1 dB.  
No immediate user action needed. 
 

 
Red: Errors or faults detected and impact is more than 1 dB.  
Immediate user action is recommended. 
 
Once the user has healed the system and uploaded array parameters, the state returns to green, but 
with an indication that healing has been performed (denoted by an “H”): 
 

 
 
If additional faults or errors occur, the progression of yellow (less than 1 dB acoustic impact) to red (1 dB 
or greater acoustical impact) will begin again with the ‘Healed’ state as the new baseline. 
 



 

 

 

  

Other Changes and Improvements: 

• Max SPL now includes effects of user EQ (both Array and Spatial). 

• Added a function to check whether a Dante transmitter has gone offline before uploading 
parameters with a Dante input assignment. User will be alerted if an array’s assigned input 
transmitter is no longer present on the network and the user attempts to upload array 
parameters. 

• Includes updated Anna data file (1.1.14), improving MF/HF phase linearity and modeled 
consistency. 

• Fixed an issue where Otto would not properly apply rejection perpendicular to array physical 
aim direction in some circumstances. 

• Fixed an issue where the tab order in the Air Loss Compensation window skipped fields. 

• Fixed an issue where the Input Assignment dialog would create multicast flows when user had 
not requested them. 

• Fixed an issue where vertical surfaces could cause unexpected directivity with Adaptive 
systems. 

• Fixed an issue where some overlapping surfaces could cause incorrect SPL predictions with 
Adaptive systems. 

• RSX208L voicing now defaults to x6-8 (white), resulting in more accurate SPL predictions with a 
majority of user configurations. 

Known Issues: 

• EASE export may fail for larger Anya arrays. 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 

o Workaround: Retry log request. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction because arrays default to aiming in the +X direction. 

o Workaround: Adjust panning so that array is aimed in –X direction (180 degrees). This 
can be done in the second page of the Array Assistant. 

• The PC may need to restart upon completion of the Resolution installation due to the updates 
to Dante Services if they are outdated. 

o Workaround: None. Allow computer to restart. Do not install new versions of 
Resolution in situations when it is critical that the computer not be restarted. If other 
programs are running, Windows will prompt the user to save their work before closing. 

o  

 
 

 



 

 

 

• Resolution may warn that an array is ‘below minimum trim’ when it is actually not, based on the 
value set in the ‘Properties’ pane. 

o Workaround: Re-run Array Assistant with modified Min Trim value. Warning should 
disappear. 

EAW Resolution v2.4.0.87 Release Notes 

Previous Version: EAW Resolution v2.3.0.123 

Resolution 2.4 contains a number of usability improvements and bug fixes, greatly improving user 
workflow in model building. For any questions, contact the Application Engineering team at 
design@eaw.com. 

NOTE: Resolution 2.4 includes updated firmware for Anna. Updating to this version of firmware is strongly 
recommended. 

Key features in this release are listed below: 

Multi-Select for Surfaces and Arrays 

Users can now manipulate properties such as Solo, Lock, Audience/Non Audience, Ear Height and 
Hidden on as well as mass deletion on multiple surfaces or loudspeakers simultaneously. This saves 
significant time when editing models. To use multi-select, hold CTRL while selecting individual surfaces 
or arrays, or SHIFT to select a range of surfaces or arrays. Users can also access multi-select functions 
from the right-click menu. 

Massive Speed Improvements 

Resolution is now significantly faster due to better utilization of multi-core CPUs, achieving speed 
increases of up to 300% over previous versions. This includes both acoustical model and SPL 
calculations. 

 
Adaptive Coverage Start/Stop Z-Override 

Adaptive array coverage can now be limited vertically, employing the same ‘z-override’ feature as in 
Spatial EQ. This can be useful in venues with balconies that overlap the main floor. In the following 
example, the Z values exclude the balcony such that the array only covers the main floor: 

 

Coverage 
overridden to be 

on floor only 

Coverage 
start/stop 
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Other Changes and Improvements: 

• RSX208L voicing now defaults to x6-8 (white), resulting in more accurate SPL predictions with a 
majority of user configurations. 

• Fixed an issue where Dante Services would require a restart after being installed but did not 
inform the user, resulting in an error until the computer was restarted. 

• Fixed an issue where Resolution would sometimes take long periods of time to change 
Adaptive coverage in very large venue and system models. 

• Fixed an issue where the 3D rotation function in Free View would not work if the model had 
vertical (90-degree) surfaces. 

• Improved Anna near-field coverage consistency in situations where audience areas are at 
extreme down-angles relative to array. 

• The Parameter Sync feature now includes even more robust error checking. 

• The Help File has been significantly updated to include new features. 

• Includes updated firmware 

o Anna -- 1.0.19.0. Improves long-term reliability in situations where the system is power 
cycled very frequently. 

 

Known Issues: 

• EASE export may fail for larger Anya arrays. 
 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 
 

o Workaround: Retry log request. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction because arrays default to aiming in the +X direction. 

o Workaround: Adjust panning so that array is aimed in –X direction (180 degrees). This 
can be done in the second page of the Array Assistant. 

• The PC may need to restart upon completion of the Resolution installation due to the updates 
to Dante Services. 

o Workaround: None. Allow computer to restart. Do not install new versions of 
Resolution in situations when it is critical that the computer not be restarted. If other 
programs are running, Windows will prompt the user to save their work before closing. 
 

  



 

 

 

EAW Resolution v2.3.0.123 Release Notes 

Previous Version: EAW Resolution v2.1.4.98 

Resolution 2.3 contains many significant improvements and bug fixes, greatly improving the user 
experience. For any questions, contact the Applications team at design@eaw.com. Note that a 
firmware update is required for Anna and Anya to access key Resolution 2.3 features. 

Key features in this release are listed below: 

 

Resolution 2.3 introduces Spatial Equalization for Adaptive Systems, a new and unique technology that 
allows users to equalize parts of the coverage by simply selecting the audience areas in which the 
change is desired and applying the desired equalization. The Adaptive system then determines the 
processing necessary to achieve the goal and implements it, in real time. This saves massive time and 
effort when on-site setting up a system and produces superior results compared to any conventional 
line array system. For the first time, users can truly EQ the room instead of the sound system. 

For more detail on this feature, please see the Spatial Equalization Technical Paper and the Spatial 
Equalization Overview video. 

 

Improved Air Loss Compensation 

This version of Resolution provides a new Air Loss Compensation algorithm for Adaptive systems, 
generating significantly greater high-frequency throw while also improving HF consistency throughout 

EQ Zone 

Total 

Coverage 
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the entire venue. Additionally, this feature allows users to optimize the HF response of their system for 
different situations, trading between headroom, throw and extension, providing up to 12 dB of 
additional HF energy at distances of 300 feet or more from the array. 

Adaptive users can access this feature by clicking on the “AL” button at the array level under the Project 
Explorer. In this control panel, users have a number of new controls: 

• Headroom Penalty – Indicates the reduction in high-frequency headroom expected with the 
current user parameters (Note: User must hit ‘Apply’ for these to be applied to the acoustical 
model). 

• Target Reference – Indicates the distance reference for the high-frequency tonality the user 
desires for the entire coverage area. In other words, the high-frequency roll-off characteristic 
for this distance will be used as a target for the rest of the coverage area.  This can be set by 
dragging the point on the graph, or by entering numerical values into the dialog box. Closer 
distances will result in more extended high-frequency response at the expense of headroom, 
while greater distances will reduce high-frequency extension but will increase headroom. 

• Rear Threshold – Indicates the distance limit to which the user wishes to maintain the target 
high-frequency tonality. This can be set by dragging the point on the graph, or by entering 
numerical values into the dialog box. Closer distances will result in greater high-frequency roll-
off at the rear of the coverage but will improve headroom, while the greater distances will 
reduce high-frequency roll-off at the rear of the audience at the expense of headroom. 

• Enhancement Level – An overall level adjustment for the amount of air loss compensation 
being applied to the system. Increasing this will improve high-frequency throw at the expense 
of headroom. 

• Presets – Provides a number of pre-defined starting points for user setup convenience. These 
are also provided in the Array Assistant. 

The control panel itself can be seen on the following page. 



 

 

 

 

 

A typical array’s high-frequency response in earlier versions of Resolution: 

 

A typical array’s high-frequency response in this version of  
Resolution. This system extends high-frequency throw, as can be  
seen by the extension of the coverage contour lines much further  
back in the venue. 

 

Preset Recall 

Enhancement 

Level 

Presets 

Front and Rear 

References 

Headroom 

Penalty 



 

 

 

This version of Resolution allows Adaptive users to easily store and recall system states via Resolution 
for quick access. With this feature, radically different coverage and voicing settings can be recalled 
within seconds with only a few mouse clicks, enabling users of all skill levels to leverage the enormous 
power of Adaptive Systems. 

As an example, Preset Recall could be used with a permanently-installed system to accommodate 
different venue uses – the main floor only, the main floor + the balcony, and only a section of the main 
floor, as examples – depending on attendance for a particular event. This ensures that the sound 
system is directing energy only where there are audience members, minimizing reverberation and 
enhancing clarity. 

The Preset Manager window (accessible via the Network Menu when online) is shown below: 

 

 
 

 

 

 

 

  

Active Preset 

Indication 

Available 

Presets  

(10 total) 

Functions 



 

 

 

Other Changes and Improvements: 

• Added feedback to the user if the Adaptive array input Dante subscription fails for any reason 
(i.e. more than 32 receivers are attempting to subscribe to a device via a unicast flow). 

• Adaptive array temperature faults now prompt the user with the option to perform Adaptive 
Healing on the array. 

• Adaptive coverage lines are now visible on elevated surfaces. 

• Number of modules that can be added to an array is now limited to 50 (formerly had no limit, so 
users could accidentally type very high numbers). 

• Fixed issue where LED settings for Adaptive modules could revert to ‘Off’ without the user’s 
input after an Array Parameter upload in some cases. 

• Fixed issue where Resolution could crash when re-running the Array Assist with a  ground-
stacked RADIUS system with RSP-1 and RSP-2 pole mounts. 

• Fixed issue where left and right Adaptive arrays could sometimes have very small differences in 
coverage due to slight venue asymmetries. 

• Fixed issue where CSV export added unexpected characters. 

• Fixed issue where side view mouse z-value was wrong when hovering over a surface with an ear 
height other than zero. 

• Fixed an issue where Array View text could be cut off when running Resolution on Windows 10. 

• Fixed an issue where the Project Explorer would not show modules in manually-added columns 
for Adaptive arrays. 

• Fixed issue where Design Factor dialog text could be cut off on Windows 10. 

• Fixed issue where Resolution could temporarily hang when the acoustical model calculation 
reaches 100%. 

• Fixed issue where locked virtual microphones could still be edited. 

• Fixed issue where right-clicking above the horizon in Free View and adding a virtual microphone 
or surface could add that object behind the user’s perspective. 

•  Includes updated firmware (update is required to use new Resolution 2.3 features): 

o Anya – 1.0.44.1 

o Anna – 1.0.18.0 

• Updated firmware for Anya also improves fan logic for reduced noise in quiet environments. 

 

 



 

 

 

 

Known Issues: 

• EASE export may fail for larger Anya arrays. 
 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 
 

o Workaround: Retry log request. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction. 

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the 
Array Assistant. The array will be inserted and the acoustic model will still calculate 
normally. 

• When installing Resolution, Dante Services requires a restart to function but does not alert the 
user. 

o Workaround: Restart the computer after installation before using Resolution. 
 

  



 

 

 

EAW Resolution v2.1.4.98 Release Notes 

Previous Version: EAW Resolution v2.1.3.84 

Resolution 2.1.4.98 contains many significant improvements and bug fixes, greatly improving the user 
experience. For any questions, contact the Applications team at design@eaw.com. Key features in this 
release are listed below: 

 

Improved Metering for Adaptive Products 

The module metering for Anya, Anna and Otto has undergone a significant redesign to provide more 
precise, clearer information. Now, users can determine available headroom before the onset of limiting 
with just a quick glance. Limit thresholds are now indicated by yellow bars on the left side of each 
channel, with gain reduction (when active) on the right side of each channel as shown below. 

 

The update speed for the metering display has also been increased by approximately 5x on Anna, 
providing much more responsive feedback to the user. This change will be implemented in Anya and 
Otto in early 2017 as well but will require a firmware update. 

Additionally, the input meter scale now changes depending on the type of input selected. When 
“Analog” is selected, the input meter units are scaled in dBu, corresponding to input voltage. When AES 
or Dante is selected, the input meter is scaled in dBFs. 

Non-Audience Surfaces 

Users can now add surfaces to a Resolution design for visual reference and SPL mapping, but exclude 
them from coverage via the “Audience” checkbox in each surface’s Properties pane. This enables users 
to now enter and display architectural surfaces in a venue (such as ceilings and walls) that are useful for 
visual reference and/or to see SPL mapping, but that should not be covered by the sound system. 

Signal Level 

Available 

Headroom 

Limit Gain 

Reduction 
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When “Audience” is unchecked, SPL will still plot on surfaces. The “Hidden” option will prevent SPL 
from plotting on surfaces, but they will still be covered by the sound system unless “Audience” is also 
unchecked. 

NOTE: Non-audience surfaces are not included in Resolution’s verification of shadowing by surfaces. In 
other words, if a surface is not indicated as “Audience”, Adaptive algorithms will completely ignore it, 
which may result in aiming lines intersecting non-audience surfaces while actually covering the 
audience surfaces behind it. 

 

By default, newly-inserted surfaces have the ‘Audience’ parameter enabled. 

 

  



 

 

 

Improved Surface Isolation for Adaptive Systems 

This version of Resolution significantly improves Anya and Anna’s ability to avoid areas between 
surfaces, both increasing the isolation of the audience surfaces from a building’s architecture and 
further improving SPL and consistency. With this improvement, SPL is reduced between audience 
surfaces by as much as 10-15 dB (the reduction will vary by audience geometry and array configuration). 

  

NOTE: It is not necessary to define non-audience areas to achieve this effect. Resolution will 
automatically reduce SPL between active audience surfaces 

 

Adaptive Aiming Lines 

Resolution now allows users to see the general aiming and allocation of sources in Adaptive arrays. 
Though this view is simplified (2 lines per enclosure), it provides users with a quick visual indication of 
how the array is covering the audience and if any areas of the venue are shadowed (Adaptive arrays will 
not ‘shoot’ through one surface to reach another). Additionally, users can quickly assess the ‘throw’ or 
coverage distance to various audience areas by simply reading the distance associated with each 
aiming line. 

 

Array Assistant with Mixed Full Range + Subwoofer Arrays 



 

 

 

Resolution’s Array Assistant will now fully optimize splay angles for arrays with mixed full-range and 
subwoofer modules, making products like RADIUS (RSX208L + RSX12), KF (KF730 + SB730) and others 
even easier to use than before. 

An example system is shown below before and after splay optimization: 

                           

 

NOTE: it is necessary to include both subwoofers and full-range modules on page 1 of the Array 
Assistant. Subwoofers will not be included in the array unless a quantity of 1 or more is added to the 
array by the user. 

 

 

Other Changes: 

• Added “Use Multicast” option when assigning inputs of Adaptive arrays. This permits more 
than 32 modules to be subscribed to a Dante transmitter (such as an Adaptive module). 



 

 

 

• Added warning when attempting to link processing for arrays of different type. 

• Improved software update status indications. 

• Suppressed tilt sensor warnings for Adaptive systems. 

• Added ability for Resolution to save directly to image files (in addition to clipboard). 

• Added option to disable acoustic calculations (“Enable Calculations”, under the “View” menu). 

• Fixed issue where Otto gain structure was lower than expected in certain rare cases. 

• Fixed issue where Resolution could crash when disconnecting from a network. 

• Fixed issue where Resolution could crash when deleting Otto modules from an array. 

• Improved Otto acoustical model calculations. Resolution will no longer sometimes pause for 
long periods of time at 40%. 

• Improved speed at which Resolution recalculates the acoustic model for Adaptive Systems 
after changes are made to a design. 

Known Issues: 

• EASE export may fail for larger Anya arrays. 
 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 
 

o Workaround: Retry log request. 

• Coverage lines are not visible on elevated surfaces (greater than z=0). 
 

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of 
model) to see location of coverage lines. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction. 

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the 
Array Assistant. The array will be inserted and the acoustic model will still calculate 
normally. 
 

  



 

 

 

EAW Resolution v2.1.3.84 Release Notes 

Previous Version: EAW Resolution v2.1.3.83 

Changes: 

Adds EAW RADIUS family loudspeaker data – NOTE: Users may need to enable loudspeakers 
and flybars in Resolution Inventory Manager (see Help File for details) in order to use them.  
Models include: 

• RSX208L line source 

• RSX129 and 126 point sources 

• RSX89 and 86 point sources 

• RSX12 flyable subwoofer 

• RSX18 ground-supported subwoofer 

• FBX100 flybar for RSX208L and RSX12 

Known Issues: 

• EASE export may fail for larger Anya arrays. 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 

o Workaround: Retry log request. 

• Coverage lines are not visible on elevated surfaces (greater than z=0). 

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of 
model) to see location of coverage lines. 

• Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for  
two arrays). 

o Workaround: N/A.  Acoustic model calculation time varies by array. Allow calculation  
to complete. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction. 

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the 
Array Assistant. The array will be inserted and the acoustic model will still calculate 
normally. 

• An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This 
occurs because routing is established as unicast flows (which have a limit of 32). 



 

 

 

o Workaround: Configure Dante flow from on-ramp module as multicast prior to 
selecting inputs in Resolution. Audio routing via Resolution (via normal input 
assignment process) will then be multicast. 

  

EAW Resolution v2.1.3.83 Release Notes 

Date: June 6, 2016 

Previous Version: EAW Resolution v2.1.2.76 

Changes: 

• Adaptive Systems Enhancements 

o Improved log files.  Saved log files can be opened via File > Open even when the devices are not 
online. 

o Improved surface detection in design mode. 

o Improvements to Anna fan speed management. 

o Added support for multicast routing. 

o General Updates 

o Improvements to the Equalizer View. 

o Resolution “updating” procedure now includes status messages. 

o Minor bug fixes. 

o  Includes updated firmware (see Help File for update procedure) 

o Anna (1.0.15.0) 

o Improves stability for systems left powered on continuously for extended periods  
of time. 

Known Issues: 

• EASE export may fail for larger Anya arrays. 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 

o Workaround: Retry log request. 

• Coverage lines are not visible on elevated surfaces (greater than z=0). 

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of 
model) to see location of coverage lines. 



 

 

 

• Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for two arrays). 

o Workaround: N/A.  Acoustic model calculation time varies by array. Allow calculation to 
complete. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction. 

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the 
Array Assistant. The array will be inserted and the acoustic model will still calculate 
normally. 

• An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This 
occurs because routing is established as unicast flows (which have a limit of 32). 

o Workaround: Configure Dante flow from on-ramp module as multicast prior to 
selecting inputs in Resolution. Audio routing via Resolution (via normal input 
assignment process) will then be multicast. 

  

EAW Resolution v2.1.2.76 Release Notes 

Date: February 17, 2016 

Previous Version: EAW Resolution v2.1.1.75 

Changes: 

• Adaptive Systems Enhancements 

o Corrected issue where when utilizing a Dante audio input, Adaptive arrays receiving 
audio from any source channel other than 1 will indicate an unsynchronized input but 
actually have the correct channel selected in Dante Controller. 

o Improved communications via Dante API, resulting in significantly faster online system 
discovery. 

o General Updates 

• Minor bug fixes. 

 

Known Issues: 

• EASE export may fail for larger Anya arrays. 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 

o Workaround: Retry log request. 



 

 

 

• Coverage lines are not visible on elevated surfaces (greater than z=0). 

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of 
model) to see location of coverage lines. 

• Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for two arrays). 

o Workaround: N/A.  Acoustic model calculation time varies by array. Allow calculation to 
complete. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction. 

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the 
Array Assistant. The array will be inserted and the acoustic model will still calculate 
normally. 

• An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This 
occurs because routing is established as unicast flows (which have a limit of 32). 

o Workaround: Configure Dante flow from on-ramp module as multicast prior to 
selecting inputs in Resolution. Audio routing via Resolution (via normal input 
assignment process) will then be multicast. 

 

EAW Resolution v2.1.1.75 Release Notes 

Date: December 17, 2015 

Previous Version: EAW Resolution v2.1.0.45 

Changes: 

• Adaptive Systems Enhancements 

• Added Anna and capabilities to generate Anna and mixed Anya/Anna arrays to Array Assistant. 

• Added Adaptive Parameter Sync feature, which continually monitors and reports 
synchronization status between Resolution and Adaptive Arrays. 

• Added ability to utilize multiple hang styles within a multi-column Adaptive array (accessed by 
the ‘Properties’ pane at the column level’). 

• Added option to ignore Tilt Errors for Adaptive products, as well as Previous/Next paging 
buttons for warning banners. 

• Improved Acoustic Measurement function for Otto and Anna. As a result, users no longer need 
to ‘Calibrate’ after driver replacement (still required for Anya). 

• Includes most recent voicings for Anya and Otto to maximize compatibility, reliability and 
performance. 

o Overall Usability Improvements 



 

 

 

• Improved SPL mapping on “Fastest” and “Normal” interpolation levels, reducing calculation 
time by up to 80% (model-dependent). 

• Added Laser and Cartesian data entry options for improved workflow when using laser distance 
meters and CAD drawings (respectively) to create venue models. 

• Added Copy, Paste and Link functions for mirroring equalization across multiple arrays. 

• Increased maximum delay time in Array Processing window from 100 milliseconds to 1,200 
milliseconds. 

• Added ability to modify quantity of modules in a column or array from Properties pane. 

• Removed ‘Overshoot’ Array Assistant function. 

• Added capability to create trapezoidal audience areas. 

• Added ‘Global Ear Height’ setting. 

• Improved reporting of maximum hang quantities for arrays. 

• Improved legibility of virtual microphone SPL in certain situation. 

• Corrected issue where Array Assistant-generated arrays can sometimes extend below 
minimum defined trim. 

• Corrected bug where EQ enable/disable state would not store with .eawresolution file. 

o Network & Dante Improvements 

• Added ability to select both primary and secondary network interfaces. 

• Non-EAW products are now listed first in Device List. 

• Improved communications via updated Dante API. 

o General Updates 

• Minor bug fixes. 

o Updated Help File. 

Known Issues: 

• When utilizing a Dante audio input, Adaptive arrays receiving audio from any source channel 
other than 1 will indicate an unsynchronized input, but actually have the correct channel 
selected in Dante Controller. 

o Workaround: None needed – this is a visual bug only. The arrays have the correct input 
assigned, as indicated in Dante Controller. 

• EASE export may fail for larger Anya arrays. 



 

 

 

o Workaround: Contact EAW Application Support for assistance in exporting EASE 
balloons for large arrays. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 

o Workaround: Retry log request. 

• Coverage lines are not visible on elevated surfaces (greater than z=0). 

o Workaround: Rotate 3D venue model perspective vertically (so as to view underside of 
model) to see location of coverage lines. 

• Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for  
two arrays). 

o Workaround: N/A.  Acoustic model calculation time varies by array. Allow calculation to 
complete. 

• The Array Assistant will sometimes indicate that the array is ‘not aimed at a surface’ for venues 
built in the –X direction. 

o Workaround: Click ‘OK’, ensure that coverage start and finish are correct, and finish the 
Array Assistant. The array will be inserted and the acoustic model will still calculate 
normally. 

• An Adaptive Systems module cannot serve as an on-ramp for more than 32 modules. This 
occurs because routing is established as unicast flows (which have a limit of 32). 

o Workaround: Configure Dante flow from on-ramp module as multicast prior to 
selecting inputs in Resolution. Audio routing via Resolution (via normal input 
assignment process) will then be multicast. 

  

 

 

 

 

EAW Resolution v2.1.0.45 Release Notes 

Date: December 18, 2014 

Previous Version: EAW Resolution v2.0.3.50 

Changes: 

• Added Otto Adaptive Subwoofer and Otto Array Assistant. 

• Several improvements to Network Configuration View for Adaptive systems, including: 



 

 

 

• Improved array self-recognition speed and accuracy. 

• Added progress bars for improved array feedback. 

• Added the ability to reboot modules remotely. 

• Added LED options to Array Configuration dialogue for Adaptive Module. 

• Added the ability to change inputs even if one or more module is offline. 

• Improved handling of communication errors via progress bars and pop-up dialogs. 

• Users now have the option to drive multi column Anya arrays either Adaptively or Uniformly 
(see Help File for more detail). 

• Anya and Otto 3D enclosure and flybar models are now significantly more detailed and realistic. 

• Adaptive systems acoustical model calculations are now more efficient; calculation time is 
greatly reduced. 

• X, Y and Z-axis lines in the negative direction are now dashed for easier identification. 

• Numbering of array elements now only includes loudspeakers (accessories such as flybars and 
adapter bars are tracked with letters instead of numbers) for easier array size identification. 

• General minor bug fixes. 

• Updated Help File. 

• Includes updated firmware (see Help File for update procedure) 

o Anya (1.0.39.0) 

• §  Adds level- and temperature-dependent fan speed control. 

• §  Power Plants now keep input panel "Test" indicator illuminated while 
powered on for improved visibility of module status. 

o Otto (0.1.9.0) 

• §  Initial release. 

Known Issues: 

• EASE export may fail for larger Anya arrays. 

o Workaround: Contact EAW Application Support. 

• Reading logs from Adaptive systems can sometimes take a long time or fail. 

o Workaround: Retry log request. 

• Coverage lines are not visible on elevated surfaces (greater than z=0). 

o Workaround: Rotate 3D venue model vertically to see location of coverage lines. 



 

 

 

• Virtual microphone SPL text sometimes does not display properly with complex surface 
geometries. 

o Workaround: Rotate 3D venue model to see text. 

• Array Assistant-generated arrays can sometimes extend below minimum defined trim in 
situations with very tight height constraints. 

o Workaround: Re-run Array Assistant with reduced array size until constraints are met. 

• Progress bar for Otto acoustic model sometimes pauses at 40% (20% or 70% for  
two arrays). 

o Workaround: N/A.  Acoustic model calculation time varies by array. 

  

EAW Resolution v2.0.3.50 Release Notes 

Date: July 7, 2014 

Previous Version: EAW Resolution v2.0.2.48 

Changes: 

• Enhanced implementation of Air Loss Compensation for very long throw distances  
using Anya. 

• Improved handling of audience surfaces shadowed from array coverage in complex venue 
geometries. 

• Updated “Create PDF” function for Anya arrays, no providing significantly more detail about 
rigging points and loads. 

• Inclusion of updated Audinate Dante Redistributable, no longer requiring some users to install it 
separately. 

• General minor bug fixes. 

  

EAW Resolution v2.0.2.48 Release Notes 

Date: April 25, 2014 

Previous Version: EAW Resolution v2.0.1.39 

Changes: 

• Added display of current cursor position 3D coordinate and SPL value. 

• Added trace storage capability for virtual microphone frequency responses. 



 

 

 

• Added audience ear height selection for each surface (used for SPL mapping, virtual 
microphone placement and array coverage calculation). 

• Minor improvements to mechanical calculations in Array Wizard, particularly for  
mixed-model arrays. 

• Removed dimensional limitations on ground-stack stage height. 

• Added “Mic SPL” toolbar button for even faster SPL calculation. 

• Improved “Copy image to clipboard” function. 

• Improved Network Configuration View functionality, including: 

• “Unassign All” right-click option for Anya arrays. 

• Array placement on page is retained with file. 

• Improved Anya-related functionality: 

• Addition of “Sapphire” voicing. 

• Improved EASE export function for Anya arrays. All columns in multi-column arrays now export 
as single balloon. 

• Improved acoustic model recalculation workflow. 

• Minor improvements to Adaptive Performance™ algorithm to handle unusual 

• Audience geometries and air loss pre-emphasis for longer throws. 

• Find Me (Trilateration) function process now includes more comprehensive dialogs. 

• Improved “Auto Identify” behavior; LEDs now turn off after 10 seconds or immediately on 
deselect. 

• Anya banner warnings are more specific. 

o Updated Help File. 

o General minor bug fixes. 

 

EAW Resolution v2.0.1.39 Release Notes 

Date: February 19, 2014 

Previous Version: EAW Resolution v2.0.1.28 

Changes: 

Improved graphical functionality, including: 

• Addition of zoom +/- functionality for frequency response window. 



 

 

 

• Users can now define the Y-value of the cross-sectional view in X-Z view. 

• Improved visibility of SPL microphones. 

• Added “Unsolo All Arrays” toolbar button. 

• Addition of shortcut keys and menu options for Free, Side and Top views. 

o Enhanced menu operation including additional right-click functions such as: 

• “Clone” feature for virtual microphones in Venue Configuration window. 

• Direct access to processing for Arrays and Loudspeakers in Project Explorer window. 

• “Add Array”, “Add Surface” and “Add Mic” in Venue Configuration window. 

o Improved “Create PDF” output and refined mechanical calculations for some 
loudspeaker models. 

o Added option to manually recalculate acoustic model if desired. 

o Improved handling of non-English characters. 

o Refined integration with Anya systems: 

• Further improved "Upload Array Parameters" behavior when making changes to model. 

• Added ability to define LED behavior. 

• Improved handling of low-frequency coverage for Anya arrays in certain near-field scenarios, 
and overall EQ optimization. 

• This installer also includes Anya voicing version 1.5 (see release notes under “Inventory 
Manager” for details). Previous voicing revisions are still included. 

o General minor bug fixes. 

 

 EAW Resolution v2.0.1.28 Release Notes 

Date: August 22, 2013 

Previous Version: EAW Resolution v2.0.0.26 

Changes: 

• Array Assistant improvements & bug fixes - “Array Wizard” changed to “Array Assistant”, 
moved aim angle to, default coverage changed from 180 to 90 degrees, online array editing 
improvements 

• Coverage assignment improvements - Asymmetrical horizontal coverage fields allowed 
(relative to array) 



 

 

 

• Frequency Response window improvements - added CSV export, copy to clipboard to right click 
menu, toggle icon bar auto re-size 

• Anya diagnostic screen improvements - more intelligent impedance feedback, acoustic 
measurement improvements 

• Added toolbar options - hide all floors button, undo/redo buttons, file & edit toolbars 

• Acoustic/SPL workflow improvements - less recalculations & button presses required 

• Microphones improvements & bug fixes - Microphones can be locked, “Find Me!” results default 
to locked 

• Array & surface naming improvements & bug fixes - “floor” changed to “surface” 

 

EAW Resolution v2.0.0.26 Release Notes 

Date: August 6, 2013 

Previous Version: EAW Resolution v1.3.1.39 

Changes: 

• Initial release of EAW Resolution 2.0 

 

For all questions, please contact design@eaw.com 
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